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Investigating flowing red blood cell (RBC) morphology and orientation is important for

elucidating physiology and disease; existing commercially available products are limited to

observing cell populations or single cells. In this protocol, we create a custom apparatus that

combines coaxial brightfield microscopy with laser diffractometry to inspect near-real-time

deformability, morphology, and orientation of flowing RBCs. There are difficulties associated

with building optical systems for biological inspection; however, this protocol provides a suitable

framework for developing an "ektacytoscope" for studying blood cells.
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SUMMARY

Investigating flowing red blood cell (RBC) morphology and orientation is impor-
tant for elucidating physiology and disease; existing commercially available
products are limited to observing cell populations or single cells. In this protocol,
we create a custom apparatus that combines coaxial brightfield microscopy with
laser diffractometry to inspect near-real-time deformability, morphology, and
orientation of flowing RBCs. There are difficulties associated with building opti-
cal systems for biological inspection; however, this protocol provides a suitable
framework for developing an "ektacytoscope" for studying blood cells.
For complete details on the use and execution of this protocol, please refer to
McNamee et al. (2020).
BEFORE YOU BEGIN

Timing: 6–12 h

The following protocoldescribes the steps required tocreateanapparatus for the inspection offlowing red

bloodcells (RBC)using small-scatter Fraunhofer diffraction analysis (ektacytometry)with concurrent coaxial

brightfield imaging. Such analyses facilitate microrheological examination of RBC in shear flow for deform-

ability/rigidity, membrane stability in shearflow, celldynamics andorientation, andcell aggregate analysis.

Prior to commencement, familiarization with the materials listed in the optical components section

of the key resources table is highly recommended.

Note: The parts list is provided as a guide to facilitate complete system assembly as outlined

in the current protocol; however, the system has been designed with modular sections where

specific parts may be easily substituted with other existing optical components.

The system assembly is presented in the recommended order of construction with three separate

stages: 1) sub-component assembly; 2) general assembly; and 3) optical system alignment. Con-

struction and alignment is only necessary at initial setup, while subsequent use of the apparatus

may be repeatedly performed as outlined in the Step-by-step method details section. After each

use, the system should be stored in a clean and dry environment, with all open apertures covered

with lens caps (e.g., Thorlabs PN: SM1EC2B or PN: SM1CP1).

Note: It is advised that the assembly of the optical system be performed in a dedicated clean

area free from dust and other contaminants. Care should be taken to keep the optical
STAR Protocols 3, 101279, June 17, 2022 ª 2022 The Author(s).
This is an open access article under the CC BY-NC-ND license (http://creativecommons.org/licenses/by-nc-nd/4.0/).
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Figure 1. The assembled optical system for combined ektacytometry and rheometry

(A–J) Functional subsections of the assembly are labeled: Brightfield illumination arm (A), Laser illumination arm (B),

Central arm and sample stage (C), Diffraction imaging arm (D), Brightfield imaging arm (E), Beam splitter cube holders

(F and G), Syringe pump, sample syringe, and shear chamber inlet tube (H), Shear chamber (I), Waste receptacle and

shear chamber outlet tube (J).
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components as clean as possible; surgical gloves should be worn when assembling, handling,

or using any part of the system to minimize risk of compromising the lenses. Users should not

directly handle or touch optical surfaces. If surfaces do require cleaning, follow appropriate

cleaning methods such as outlined by Thorlabs (Thorlabs Inc., 2022) or Edmund Optics (Ed-

mund Optics Inc., 2022).

The completed ektacytometer-rheometer optical system assembly is presented in Figure 1 and

Methods video S1. For ease of construction, general assembly is grouped into functional sections:

brightfield illumination arm (Figure 1A), laser illumination arm (Figure 1B), central arm and stage

holder (Figure 1C), laser diffraction imaging arm (Figure 1D), brightfield imaging arm (Figure 1E),

beam splitter cube A (Figure 1F), beam splitter cube B (Figure 1G).
Institutional permissions

While ethical approval is not required to build an optical apparatus, in order to collect blood human

samples (see blood collection and preparation), relevant ethical approval from a Human Research

Ethics Committee must be ascertained. This ethical approval must conform with institutional and na-

tional guidelines, as well as the declarations of Helsinki.
2 STAR Protocols 3, 101279, June 17, 2022
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Sub-component assembly

Timing: 3 h

The sub-component assembly describes the initial setup and construction required for each optical

module to be assembled from individual pieces. Sub-component assembly is described with refer-

ence to highlighted functional sections in Figure 1.

1. Brightfield illumination arm (Figure 2).

The brightfield illumination arm (Figure 1A) houses the optics required to generate uniform bright-

field Köhler illumination for the microscope imaging path. Adjustment of the illumination field and

aperture will be performed using the field diaphragm and aperture diaphragm respectively.

For assembly, the parts listed in key resources table under subheading ‘‘Illumination – Brightfield’’

are required.
Figu

(A–G

lens

figur
a. Assemble the field stop diaphragm.

i. Ensure that the two plate-movement-locking 2 mm cap screws on a 30 mm XY slip plate

positioner (PN: SPT1C/M) are tightened sufficiently to maintain position when released,

while still allowing the plates to be adjusted.

ii. Lock the movement of the knurled iris aperture adjustment ring on a SM1 ring-actuated

iris (PN: SM1D12C) using the locking grub screw.

iii. Screw the external SM1 thread of the iris onto the movable face of the XY slip plate posi-

tioner making sure it is firmly affixed.

iv. Unlock the movement of the iris by undoing the locking grub screw.

b. Assemble the relay lens.

i. Screw the external SM1 threads of a 35 mm mounted biconvex lens (PN: LB1811-A-ML)

onto a 30 mm cage plate (PN: CP08/M).

c. Assemble the aperture stop diaphragm.

i. Prepare the field stop diaphragm by repeating steps 1a.i–1a.iv.

d. Assemble the second collector lens.

i. Screw the external SM1 threads of a 60 mm mounted achromatic doublet lens (PN: AC254-

060-A-ML) onto a 30 mm cage plate (PN: CP08/M).

e. Assemble the first collector lens.

i. Screw one end of an SM1 lens tube coupler (PN: SM1T2) into a 30 mm cage plate (PN:

CP08/M).
re 2. Detail of the brightfield illumination arm with sub-component assemblies

) Field stop diaphragm (A), Relay lens (B), Aperture stop diaphragm (C), Second collector lens (D), First collector

(E), Broadband light source diaphragm (F), Broadband light source (G). (Note: slight variations exist between the

e and instructions for parts A, E, and G. See the included CAD model for an updated assembly reference).

STAR Protocols 3, 101279, June 17, 2022 3
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ii. Thread the coupler two or three full rotations into the cage plate then lock it off with a

retaining ring.

iii. Take a mounted 40 mm achromatic doublet lens (PN: AC254-040-A-ML) and screw it into

the other side of the lens tube coupler.

iv. Thread the lens on two or three full rotations and lock it off with the second retaining ring.

v. Screw a 50 mm 1/200 post (PN: TR50/M) into the M4 tapped hole of the cage plate.

vi. Prepare a 50 mm 1/200 post holder (PN: PH50/M) with a mounting base plate (PN: BA1S/

M) by bolting the two together with a 10 mm M6 cap screw through the bottom of the

mounting base such that the cap screw is contained within the recess and the post holder

is sitting flush on top.

vii. Place the post into the post holder and lightly tighten the thumbscrew.

Note: Assemble the cage plates such that the M4 mounting hole is oriented toward the

breadboard or ‘bottom’ surface. This will align the clamping setscrews and bolts facilitating

subsequent access for alignment steps.

f. Assemble the broadband light source diaphragm.

i. Prepare a Ø36 mm aperture mounted iris (PN: ID36/M) by unscrewing it from its 1/200 post.

ii. Unscrew the M4 mounting grub screw out of a 50 mm 1/200 post (PN: TR50/M).

iii. Screw the iris onto the 50 mm post.

iv. Prepare a 50 mm 1/200 post holder (PN: PH50/M) with a mounting base plate (PN: BA1S/

M) as per step 1.e.vi.

v. Align the post holder thumbscrew so it is on the same side of the base with the mounting

slot.

vi. Place the post into the post holder and lightly tighten the thumbscrew.

vii. Attach a slip-on post collar (PN: R2/M) onto the post such that it is sitting flush against the

bottom of the top of the post holder. Ensure that the setscrew inside of the post collar is

not protruding from the collar body.

g. Assemble the broadband light source.

i. Prepare a quartz tungsten-halogen lamp (PN: QTH10/M) by attaching a 50 mm 1/200 post

into the M4 tapped hole on the base.

ii. Remove the end cap closest to the electrical cable input to the lamp using an SM1

spanner wrench (PN: SPW909).

iii. Prepare a 30 mm 1/200 post holder (PN: PH30/M) with a mounting base (PN: BA1S/M) by

bolting the two together with a 10 mm M6 cap screw through the bottom of the mounting

base such that the cap screw is contained within the recess and the post holder is sitting

flush on top.

iv. Align the post holder thumbscrew so it is on the same side of the base with the mounting slot.

v. Place the post into the post holder and lightly tighten the thumbscrew.

vi. Attach a slip-on post collar (PN: R2/M) onto the post such that it is sitting flush against the

top of the post holder. Ensure that the setscrew inside of the post collar is not protruding

from the collar body.

Note: The broadband light source used in the current protocol was an Olympus tungsten fila-

ment 6V 15W light bulb (PN: LS15) with associated adapter. Alternative light sources may be

used as a replacement such as the QTH10/M as described. Adjustment may be needed If us-

ing alternative light sources with integrated collector lenses (e.g., the aspheric lens in the

QTH10/M of which was bypassed in this protocol). In such a case the first collector lens

may be removed and the system completed with the integrated collector lens and the sec-

ond collector lens.
2. Laser illumination arm (Figure 3).

The laser illumination arm (Figure 1B) houses the laser light source and the associated collimating

and alignment components. Adjustment of the laser collimation and spot size is performed with
STAR Protocols 3, 101279, June 17, 2022



Figure 3. Detail of the laser illumination arm with sub-component assemblies

(A and B) Laser mount (A), ND filter holder post (B).

ll
OPEN ACCESSProtocol
the laser mount and focusing ring. After alignment, these controls are fixed unless realignment is

required during troubleshooting.

For assembly, the parts listed in key resources table under subheading ‘‘Illumination – Laser’’ are

required.

a. Assemble the laser mount.
i. Screw a 50 mm 1/200 post (PN: TR50/M) into the M4 tapped hole of a small v-clamp

adapter (PN: VC1/M) – ensure to use the mounting hole directly under the v-groove.

ii. Prepare a 50 mm 1/200 post holder (PN: PH50/M) with a mounting base plate (PN: BA1S/M)

as per step 1.e.vi.

iii. Place the post into the post holder and lightly tighten the thumbscrew.

iv. Loosen the nylon tipped setscrew on the top of the clamping arm of the v-clamp such that

the nylon tip is just past the bottom of the clamping arm.

v. Loosen the cap screw holding the clamping arm onto the support shaft so that the clamp-

ing arm is free to move.

vi. Place the laser (PN: LM-6305MR) onto the v-clamp such that the body of the laser is sitting

in the v-groove with the silver focus adjustment ring just ahead and free of the v-clamp

body.

vii. Move the clamping arm such that it is perpendicular to the laser body and the nylon tip is

�2 mm above the body of the laser.

viii. Tighten the cap screw to fix the clamping arm in place, then tighten the setscrew to affix

the laser and immobilize it in the v-clamp.

Note: Make sure to mount the laser body onto the v-clamp mount close to the adjustment

ring. This will assist in minimizing lateral movement with rotational adjustments in subse-

quent alignment phases.

Note: A laser mount with kinematic adjusters could be substituted for the optical post and

v-clamp mount to improve ease and precision during adjustment and alignment.

b. Assemble the ND filter holder post.

i. Screw a 50 mm 1/200 post (PN: TR50/M) into the M4 tapped hole of a fixed lens mount (PN:

SMR1/M).

ii. Prepare a 50 mm 1/200 post holder (PN: PH50/M) with a mounting base plate (PN: BA1S/M)

as per step 1.e.vi.

iii. Place the post into the post holder and lightly tighten the thumbscrew.

3. Central arm and sample stage (Figure 4).

The central arm and sample stage (Figure 1C) houses the objective, condenser lens, sample stage,

and slit flow chamber. Adjustment of the brightfield condenser focus, objective lens focal length,
STAR Protocols 3, 101279, June 17, 2022 5



Figure 4. Detail of the central arm and sample stage with sub-component assemblies

(A–C) Condenser lens (A), Objective lens holder (B), XY slit flow chamber stage holder (C). (Note: the XY slit flow

chamber stage holder and linear stage in the image is no longer commercially available. While a different stage holder

could be manufactured/printed, to maximize accessibility alternate components that are currently commercially

available are listed in the work instructions and key resources table. See the included CAD model for an updated

assembly reference).

ll
OPEN ACCESS Protocol
and diffraction image collection will be performed using the condenser lens assembly, objective lens

assembly, and sample stage assembly.

For assembly, the parts listed in key resources table under subheading ‘‘Central arm and sample

stage’’ are required.
6

a. Assemble the condenser lens.

i. Screw one end of a SM1 lens tube coupler (PN: SM1T2) into a 0.500 thick 30 mm–60 mm

cage plate adapter (PN: LCP33/M).

ii. Thread the coupler two or three full rotations into the cage plate then lock it off with one

of the retaining rings.

iii. Take a mounted 30 mm achromatic doublet lens (PN: AC254-030-A-ML) and screw it into

the other side of the lens tube coupler.

iv. Thread the lens in two or three rotations and lock it off with the second retaining ring.

b. Assemble the XY slit flow chamber stage holder.

i. Place the two included dowel pins of a side actuated 1/400 travel translation stage (PN:

MS1S/M) into the associated dowel pin holes on the bottom of the stage.

ii. Mount the stage onto a base plate for ‘MS series translation stages’ (PN: MS101) such that

the travel of the stage is parallel with the M6 mounting slots of the base plate.
STAR Protocols 3, 101279, June 17, 2022
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iii. Bolt the stage to the base using a 10 mm M4 bolt through the M4 mounting hole on the

centre of the base.

iv. Place a 20 mm 1/200 post holder (PN: PH20/M) over the centre of the top of the stage and

align the thumbscrew to be on the side of the micrometre adjuster. Bolt the post holder to

the base using a 12 mm M4 button head bolt and washer.

v. Screw in a 20 mm 1/200 post to the centre hole of three on the bottom of an XY translation

mount for rectangular optics (PN: XYF1/M).

vi. Place the post into the post holder.

c. Assemble the objective lens holder.

i. Starting with a 30 mm cage Z-axis translation mount (PN: SM1ZA) screw in an SM1 to RMS

thread adapter (PN: SM1A3) from the side of the translation mount with the micrometre

dial where the spanner wrench slots face outward.

ii. Attach the adapter by threading it so �1 mm is still protruding above the face of the

movable SM1 mount.

iii. Lock the position of the threaded adapter by screwing in an SM1 retaining ring (PN:

SM1RR) from the opposite site until it is firmly affixed using an SM1 ring wrench (PN:

SPW602).

iv. Screw the Olympus UPLAN FLN 103 objective lens (PN: 1-U2B524) into the adapter such

that it is firmly affixed with finger pressure only.
4. Diffraction imaging arm (Figure 5).

The diffraction imaging arm (Figure 1D) houses the optics and camera for collecting the diffraction

image. After alignment these optics will be set unless realignment is required during
re 5. Detail of the diffraction imaging arm with sub-component assemblies

d B) Diffraction imaging camera assembly (A) and Diffraction camera tube lens (B).

STAR Protocols 3, 101279, June 17, 2022 7
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troubleshooting.

For assembly, the parts listed in key resources table under subheading ‘‘Diffraction Imaging Arm’’

are required.

a. Assemble the diffraction imaging camera assembly (Figure 5A).
i. Screw the external SM1 Threads of an absorptive neutral density filter (PN: NE10A-A) onto

a 30 mm cage plate (PN: CP08/M).

ii. Screw one end of an SM1 lens tube coupler (PN: SM1T2) into the opposite end of the cage

plate.

iii. Thread the coupler two or three full rotations into the cage plate then lock it off with one of

the retaining rings.

iv. Starting with the mounting sleeve (PN: 108029(HS503)) for the USB camera (PN:

S3CMOS05000KPA), screw an SM1-to-C mount adapter (PN: SM1A9) into the threaded

side of the sleeve.

v. Loosen the grub screw on the adapter and slip it onto the USB camera barrel and tighten

the grub screw.

vi. Screw the SM1-to-C mount adapter into the other side of the lens tube coupler.

vii. Thread the adapter using at least two rotations, and so the grub screw is on either the left

or the right side of the cage plate.

viii. Lock the adapter in place with the second retaining ring.

ix. Prepare a 50 mm 1/200 post holder (PN: PH50/M) with a mounting base plate (PN: BA1S/M)

as per step 1.e.vi.

x. Place the post into the post holder and lightly tighten the thumbscrew.

b. Assemble the diffraction camera tube lens (Figure 5B).

i. Screw the external SM1 threads of a 100 mm mounted achromatic doublet (PN: AC254-100-

A-ML) onto a 30 mm cage plate (PN: CP08/M)

5. Brightfield imaging arm (Figure 6).

The brightfield imaging arm (Figure 1E) houses the camera for collecting the associated imagery.

After alignment these controls are fixed unless troubleshooting indicates that realignment is

required.

Note: A modification of this arm may include a tube lens for greater flexibility and clarity of the

captured image.

For assembly, the parts listed in key resources table under subheading ‘‘Brightfield Imaging Arm’’

are required.

a. Assemble the brightfield imaging camera assembly
8

i. Unscrew the SM1 retaining ring from a Ø100 stackable lens tube (PN: SM1L03) using an SM1

ring wrench (PN: SPW602).

ii. Noting the marked arrow direction on a 633 nm notch filter (PN: NF633-25), mount the filter

inside the lens tube such that the arrow is pointing towards the external threading lip and

away from the direction of insertion.

iii. Using the ring wrench carefully screw the retaining ring into the lens tube and secure the

notch filter.

iv. Screw the external SM1 threads of the mounted notch filter onto a 30 mm cage plate (PN:

CP08/M).

v. Continue assembling the brightfield imaging camera assembly as per steps 4.a.ii–4.a.x.

Note: To collect high quality brightfield imaging data of RBC in shear, image acquisition using

short exposure times and high frame rates is recommended. The camera used for data collec-

tion as analyzed in the current protocol was the Dantec FlowSense EO 2M. If such a camera is

available, it is advised to swap out the ToupTek camera by unscrewing the mounting sleeve
STAR Protocols 3, 101279, June 17, 2022



Figure 6. Detail of the brightfield imaging arm with sub-component assemblies

(A) Brightfield imaging camera assembly (A).
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from the C-mount adapter and affixing in the new camera. If the new camera is not a C-mount

then a suitable adapter will need to be substituted.

6. Beam splitter cube holders (Figure 7).

The beam splitter cube holders (Figures 1F and 1G) form the junctional attachment between each

functional arm of the assembled optical system.

For assembly, the parts listed in key resources table under subheading ‘‘Beam Splitter Cubes’’ are

required.
a. Beam splitter cube holder A (for trans-brightfield illumination and laser imaging).

i. Starting with a mounting base (PN: BA2/M) bolt a 50 mm Ø1/200 post holder (PN:

PH50/M) into the centre mounting hole using a 10 mm M6 cap screw.

ii. Take a 50 mm Ø1/200 post (PN: TR50/M) and screw it into the centre mounting hole on

the bottom of a kinematic beam splitter cube cage mount (PN: DFM1BS/M).
STAR Protocols 3, 101279, June 17, 2022 9



Figure 7. Detail of the beam splitter cube holders with sub-component assemblies

(A and B) Beam splitter cube holder A (A), and Beam splitter cube holder B (B).

ll
OPEN ACCESS

10

Protocol
iii. Attach a slip-on post collar (PN: R2/M) onto the post such that it is sitting flush against

the bottom of the cage cube mount. Ensure that the setscrew inside of the post collar is

not protruding from the collar body.

iv. Insert the post and cage cube mount into the post holder.

v. Remove the beam splitter cube holder insert and place it upside down on a flat surface.

vi. Completely loosen the two captive screws holding the insert together and separate the

two halves.

vii. Carefully place the 50:50 cube beam splitter (PN: BS013) onto the smaller half of the insert

with the captive screws (hereby referred to as retention clamp) such that the frosted surface

of the beam splitter cube engraved with markings rests on the ledge of the retention clamp.

Note: Exercise caution when handling the beam splitter cube. Handle it only from the frosted

non-optical surface faces.

viii. Orientate the cube such that the corner tangent to the inner beam splitter coating with a

single arrow (not two arrows) is towards the captive screws (See Figures 8 and 9).

Note: Ensure that the beam splitter cube is mounted in the correct orientation to ensure

proper operation of the system.

ix. Carefully pick up the retention clamp and beam splitter cube. Place it gently back into

the cube insert.

x. Tighten the two screws joining the two halves back together, alternating between each

screw after every two rotations. Ensure the screws of the cube retention clamp are fully

tightened.
STAR Protocols 3, 101279, June 17, 2022



Figure 8. Beam splitter cube alignment

Detail of beam splitter cube alignment for cube

holder A showing correct orientation with the corner

of the cube tangent to the inner beam splitter coating

with a single arrow (not two arrows) towards the

captive bolts.
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xi. Replace the beam splitter cube holder insert back into the beam splitter cube cage

mount body.

xii. Unscrew the SM1 retaining ring from a Ø100 stackable lens tube (PN: SM1L03) using an

SM1 ring wrench (PN: SPW602).

xiii. Place a 60 mm biconvex lens (PN: LB1596-A) inside the lens tube.

xiv. Using the ring wrench carefully screw the retaining ring into the lens tube and secure the

lens.

xv. Mount the lens tube on the face of the cube cage mount with the Thorlabs logo and part

number displayed on top.

xvi. On the right face of the cage cube mount, as seen from the face looking towards the

biconvex lens, mount a 0.1600 thick 30 mm–60 mm cage plate adapter (PN: LCP4S) using

four 3/1600 long 4–40 cap screws. To keep the adapter plate aperture concentric with the

cube cage aperture, align the cage plate by screwing in two ER rods on opposite cor-

ners, and screwing the cap screws in the other two free corners. Remove the two ER

rods and screw in the last two cap screws.
Figure 9. Beam splitter cube alignment

Detail of beam splitter cube alignment for cube

holder A showing correct orientation with the corner

in line to the inner beam splitter coating with a single

arrow next to and pointing away from the captive

bolts. The corner with two arrows is on the opposite

side and pointing away from the captive bolts.

STAR Protocols 3, 101279, June 17, 2022 11
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xvii. Insert a snap-on lens tube dust cover (PN: SM1EC2B) into the aperture opposite the

biconvex lens.

b. Beam splitter cube holder B (for epi laser illumination and brightfield imaging).

i. Repeat steps 6.a.i–6.a.vi.

ii. Carefully place the 30:70 cube beam splitter (PN: BS019) onto the retention clamp such

that the frosted surface of the beam splitter cube engraved with markings is resting on

the ledge of the retention clamp.

Note: Exercise caution when handling the beam splitter cube. Handle it only from the frosted

non-optic surface faces.

iii. Orient the cube such that the corner in line to the inner beam splitter coating with a sin-

gle arrow (not two arrows) is pointing away from the retention clamp body.

Note: Ensure that the beam splitter cube is mounted in the correct orientation to ensure

proper operation of the system.

iv. Carefully pick up the retention clamp and beam splitter cube and place it gently back

into the cube insert.

v. Tighten the two screws joining the two halves back together, alternating between each

screw after a couple rotations each time.

Note: Ensure the screws of the cube retention clamp are tightened all the way.

vi. Replace the beam splitter cube holder insert back into the beam splitter cube cage

mount body.

vii. Mount a 50 mm biconvex lens (PN: LB1471-A-ML) on the face of the cube cage mount

with the Thorlabs logo and part number displayed on top.

viii. On the left face of the cage cube mount (as seen from the face looking towards the

biconvex lens) mount a 0.1600 thick 30 mm–60 mm cage plate adapter (PN: LCP4S) using

four 200 ER cage rods.

ix. Insert a snap-on lens tube dust cover (PN: SM1EC2B) into the aperture opposite the

biconvex lens.
7. Breadboard base.

The optical breadboard forms the base of the system. The system may be built on an optical table or

other suitable platforms if preferred.

For assembly, the parts listed in key resources table under subheading ‘‘Breadboard Base’’ are required.

a. Orient the optical breadboard (PN: MB4560/M) such that the recessed feet mounting holes

are facing up.

b. Place four sorbothane feet (PN: AV4/M) at the four corners of the breadboard lined up under-

neath the recessed mounting holes.

c. Using 12 mm long M6 cap screw, bolt each of the four feet into the breadboard.

General assembly

Timing: 3 h

The general assembly describes the setup and placement of each sub-component (described

above). General assembly is described with reference to highlighted functional sections in Figure 1.

8. Assemble breadboard and splitter cube A.

See Figures 2 and 4 for reference of assembly.
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a. Begin with the optical breadboard assembly placed in a landscape position, place the Beam

splitter cube A as per Figure 7 with the short side of the base facing towards the front edge.

b. Position the base of splitter cube A such that the mounting slots line up with the 7th and 8th

mounting holes on the first and third row from the top left. Attach the base to the optical

breadboard using four 20 mm M6 bolts and washers.

c. Push the base against the two left side bolts and use a flat object to assist alignment parallel to

the optical breadboard’s front edge.

Note: To prevent marring of the base surface when mounting the base components to the

breadboard using M6 bolts and washers, orient the washers such that the convex side is facing

the base and the concave side is facing the bolt head.

d. Loosen the post holder for the splitter cube A and rotate the post in the post holder such that

the Thorlabs logo and part number are facing towards the front edge, and the splitter cube A is

parallel to the edges of the breadboard. Tighten and lock the post holder.

9. Assemble laser diffraction imaging arm.

See Figure 5 for reference of assembly.

a. Attach four 600 cage rods (PN: ER6) to the left face of splitter cube A.

b. Thread the tube lens assembly onto the cage rods such that the optic is mounted on the side of

the cage mount towards the splitter cube. Push the assembly all the way down the cage rods.

Note: When threading on the cage plates ensure the M4 mounting hole is facing towards the

breadboard.

c. Thread the diffraction imaging arm assembly onto the cage rods such that the camera aperture

is facing the cube holder. Using a vernier caliper or ruler, adjust the height of the 1/200 post as

necessary within the post holder to align the height of the cage plate with the height of the tube

lens cage plate.

d. Rotate the base of the assembly and attach it to the 2nd mounting hole on the third row from

the top left of the breadboard base using a 20 mm length M6 bolt and washer.

e. Tighten the bolt up to �90%. The camera assembly should still be able to slide along the rail

for repositioning as required in alignment stages.

10. Assemble brightfield illumination arm.

See Figure 2 for reference of assembly.
a. Screw four 1000 cage rods (PN: ER10) onto the front face of splitter cube A (i.e., the face with

the Thorlabs logo and part number).

b. Thread the field diaphragm assembly onto the 1000 cage rods, with diaphragm mounted on

the side of the cage mount away from splitter cube A.

c. Thread the relay lens onto the 1000 cage rods such that the lens is facing away from splitter

cube A.

d. Thread the aperture diaphragm onto the 1000 cage rods with the diaphragm mounted on the

side farthest from splitter cube A.

e. Thread the second collector lens with the orientation of the lens body positioned farthest

away from splitter cube A.

f. Thread the first collector with the lens body positioned away from splitter cube A.

g. Using a vernier caliper or ruler, adjust the height of the 1/200 post as necessary within the post

holder to align the height of the cage plate and the height of the field diaphragm cage plate.

h. Rotate the base of the assembly and bolt it to the 9th mounting hole on the 13th row from the

top left of the breadboard using a 20 mm M6 bolt and washer.

i. Tighten the bolt to �90%. The first collector lens should be secure, but able to be reposi-

tioned along the rail as needed for alignment.
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j. Place the base of the broadband light source diaphragm assembly onto the breadboard with

the long axis roughly parallel to the long axis of the breadboard.

k. Bolt it to the 6th mounting hole on the 15th row from the top left of the breadboard base us-

ing a 20 mm M6 bolt and washer. Tighten to �90%.

l. Place the base of the broadband light source assembly onto the breadboard such that its

long axis is roughly parallel to the long axis of the breadboard and the open face of the

lamp body is facing the first collector lens.

m. Bolt it to the 9th mounting hole on the 17th row from the top left of the breadboard base us-

ing a 20 mm M6 bolt and washer. Tighten the bolt up 90%.
11. Assemble splitter cube B and objective lens.

See Figure 4 for reference of assembly.
a. Place splitter cube B onto the breadboard with its short side facing towards the front

edge of the breadboard. Position the base with the centre of the mounting slots lined

up with the 16th mounting holes on the 1st and 3rd row from the top left of the bread-

board.

b. Proceed to bolt the base to the optical breadboard using two M6 bolts and washers, tight-

ened to �90%. Use a flat object or spare base to help line up the base parallel to the bread-

board’s top edge.

c. Thread the objective lens holder assembly onto the 200 cage rods orientated with the objec-

tive lens away from the splitter cube B. Push the assembly against the adapter plate to give

working room.
12. Assemble brightfield imaging camera.

See Figure 6 for reference of assembly.
a. Screw four 300 cage rods (PN: ER3) onto the right face of splitter cube holder B.

b. Thread the brightfield imaging camera assembly onto the cage rods with the camera aper-

ture facing the cube holder.

c. Using a vernier caliper or ruler, adjust the height of the 1/200 post as necessary within the post

holder to align the height of the cage plate with the diffraction camera tube lens.

d. Rotate the base of the assembly and bolt it to the 20th mounting hole on the 3rd row from the

top left of the breadboard base using 20 mm M6 bolts and washers.

e. Tighten the bolt to �90% such that the camera assembly may still be repositioned along the

rail in subsequent alignment steps.
13. Assemble central arm.

See Figure 4 for reference of assembly.
a. Thread three 800 cage rods (PN: ER8) �25 mm through the holes of the cage plate adapter on

the right side of splitter cube A. Two rods should be threaded through the top two holes and

one rod should be threaded through the bottom right hole towards the rear of the bread-

board.

b. Thread the collector lens assembly onto these cage rods with the lens facing towards the

objective lens.

c. Continue threading the 800 cage rods through the cage plate adapter until they reach the

60 mm cage plate adapter on splitter cube B.

Note: When threading the 800 cage rods, ensure that the two beam-splitter cube holder assem-

blies are parallel. Adjust the placement or rotation of the assemblies as needed.

d. Centre the cage rod between the two cage plate adapters and lock the movement of the rods

using the setscrews on the cage plate adapters.

e. Tighten the M6 bolts on the bases of the two beam-splitter cube holder assemblies to secure

them to the breadboard.
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14. Assemble stage holder.

See Figure 4 and Figure 10 for reference of assembly.
a. Remove the XY stage from the translation base post holder.

b. Place the base plate onto the breadboard with the mounting slots parallel to the long sides of

the breadboard and micrometre positioned towards the back edge.

c. Bolt the base to the breadboard using two 10 mm M6 cap screws in the 1st and 3rd mounting

holes on the 12th row from the top left of breadboard.

d. Position the micrometer stage in its center of travel.

e. Use the M6 mounting slots on the base to align the post holder roughly 75 mm from splitter

cube B. Use the travel on the mounting slots for coarse alignment and the micrometer stage

travel for fine adjustment.

f. Place the XY stage back into the post holder. Lift the stage in the post holder to allow lateral

movement without impediment by the lower ER cage rod.
15. Assemble laser illumination light source and arm.

See Figure 3 for reference of assembly.
a. Place the base of the laser assembly onto the breadboard with its long axis parallel to the

long axis of the breadboard and mounting slot facing to the right.

b. Bolt it to the 17th mounting hole on the 17th row from the top left of the breadboard base

using 20 mm M6 bolts and washers and tighten �90%.

c. Adjust the post to position the body of the laser diode perpendicular to the base.

d. Place the base of the ND filter holder post into the 17th mounting hole on the 15th row from

the top left of the breadboard using 20 mm M6 bolts and washers. Tighten �90%.

e. Move the body of the ND filter holder post to center the ND filter with the laser diode

aperture.
Optical system apparatus alignment

Timing: 4 h

The optical system apparatus alignment describes the process for adjusting and aligning each

sub-component and module to acquire suitable brightfield and laser diffraction imaging for

analysis.

16. Align Köhler illumination for brightfield imaging.
a. Remove the XY translation stage from its post holder.

b. To creating working room during the alignment process, move the objective assembly to-

wards splitter cube B and secure in place with one of the setscrews on its cage mount. Move

the condenser lens next to the objective lens, and secure in place using one of the setscrews

on its cage mount.
Figure 10. Slit flow shear chamber secured and

positioned in the sample stage holder assembly

Note: Objective lens assembly retracted out of the

way for picture.

STAR Protocols 3, 101279, June 17, 2022 15



ll
OPEN ACCESS

16

Protocol
c. Perform a rough alignment for each component on the Köhler illumination arm following

steps 16.d–16.i. Once each component is in place, fix its movement by tightening the set-

screws or set bolts.

Note: When measuring distances between the optical components using vernier calipers or a

ruler, ensure to measure from the center of the optic or aperture itself (this is not often the

center of the mounting tube). For more detailed information on focal lengths for the different

optics, consult the reference drawings and measurements from the relevant supplier.

d. Adjust the position of the field stop diaphragm to one focal distance (i.e., 60 mm) from the

lens on splitter cube A.

e. Adjust the relay lens to one focal distance (i.e., 35 mm) from the field stop diaphragm.

f. Adjust the aperture stop diaphragm to one focal distance (i.e., 35 mm) from the relay lens.

g. Adjust the second collector lens to one focal distance (i.e., 60 mm) from the aperture diaphragm.

h. Adjust the first collector lens to be 60 mm from the second collector lens.

Note: The space between the collector lenses is conjugated to an infinite distance by both

lenses. The distance between them can therefore be adjusted as desired. It is recommended

to position them between 40 mm–60 mm apart.

i. Adjust the position of the broadband light source and broadband light source iris such that

the filament of the light source is roughly one focal distance (i.e., 40 mm) from the first col-

lector lens.

j. Turn on the broadband light source.

k. Close the iris of the; field stop diaphragm, aperture stop diaphragm, and broadband light

source diaphragm.

l. Move the broadband light source towards and away from the first collector lens until an im-

age of the lamp filament is focused onto the aperture diaphragm.

m. Loosen the slip-on post collar and post holder thumbscrew of the broadband light source

assembly. Adjust the position of the light source (left, right, up, and down) until the lamp

filament image is centered on the aperture diaphragm.

n. Tighten the slip-on post collar on the 1/200 post just above the post holder. Tighten the post

holder thumbscrew and M6 bolt of the broadband light source assembly base.

Note: When tightening maintain holding pressure and continue to adjust so that the align-

ment is maintained.

o. Loosen the slip-on post collar and post holder thumbscrew of the broadband light source

diaphragm assembly.

p. Adjust the position of broadband light source diaphragm such that the body of the dia-

phragm is sitting flush on the broadband light source aperture. Adjust the position of the

iris to center the incident light on the field stop diaphragm.

q. Tighten the slip-on post collar on the 1/200 post just above the post holder. Tighten the post

holder thumbscrew and M6 bolt of the broadband light source iris assembly base.

r. Open the aperture diaphragm completely.

s. Keeping the field diaphragm closed. Use a 60 mm cage alignment plate (PN: LCPA1) or a

white viewing screen (such as a piece of paper) to check that there is a clear collimated im-

age of the lamp filament between splitter cube A and the condenser. The image should be

clear and focused for �10–20 mm beyond the splitter cube assembly. If the image is not

clear or focused, check the focal distances and alignment by repeating steps 16.c–16.q.

Note: You may need to open the field diaphragm slightly to allow more working light during

the process of alignment in step 16.s.
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t. Open the field diaphragm completely.

u. Using a cage alignment plate or viewing screen, scan back and forward just beyond the

beam splitter cube assembly in the central arm and find the position where the image of

the lamp filament is the sharpest. This is �4 mm from the aperture of the beam splitter

cube holder.

v. Move the condenser to one focal distance (i.e., 30 mm) away from the position found in step

16.u. Secure it in place using one of the cage plate adapter setscrews.

w. Replace the XY slit flow chamber stage back into its post holder.

x. Align the linear travel of the XY stage perpendicular to the optical axis.

y. Undo the nylon-tipped grub screws of the XY stage and insert the slit flow chamber (PN:

80161). Adjust the horizontal holding arms as necessary to fit the chamber inside. Affix

the chamber using the nylon-tipped grub screws.

z. Align the clear aperture of the slit flow chamber vertically to the center of the optical illumi-

nation axis.

aa. Adjust the positioning of the XY stage using the 1/400 travel translation stage such that the

focal plane of the condenser lens is conjugate on the face of the slit flow chamber closest to

the condenser lens. The position of the XY stage base may be adjusted with the M6 cap

screws if required.

ab. Connect the brightfield imaging camera to a computer and initiate live video acquisition.

ac. Adjust the broadband light source iris aperture such that light just fills the aperture of the

first collector lens.

ad. Adjust the aperture diaphragm such that it is about 70%–80% diameter of the light image

incident on it.

ae. Close the field diaphragm.

af. In the camera acquisition software, adjust the resolution, turn off auto exposure and auto

white balance, and manually adjust the exposure of the image such that it is not over

exposed.

Note: The maximum achievable frame rate is dependent on the hardware, exposure levels/

lumens, and selected acquisition resolution. Higher frame rates are usually achievable at

lower resolution acquisition.

gg. Slowly move the objective lens assembly forward on the cage rods until the face of the slit

flow chamber closest to the condenser lens is in focus. Tighten the setscrews on the cage

plate to fix the objective lens assembly. Adjust the micrometer head on the Z-axis transla-

tion mount for fine focusing of the desired optical depth.

hh. Move the condenser lens until the field diaphragm is in focus. Sharp edges of the

diaphragm leaves should be in focus on the camera image.

ii. Lock the position of the condenser lens in place using the cage plate setscrews.

jj. Centre the field diaphragm on the camera image by adjusting its position using the field

diaphragm assembly slip plate.

kk. Open the field diaphragm iris such that it is just wider than what is visible in the camera

image.
17. Align laser illumination for diffraction imaging.

CRITICAL: The current optical system uses a class 3R laser diode module. Before powering
the laser light source, safety for handing and use must be carefully considered. Follow all

safety protocols and regulations for use of such a class of device.
a. Attach two 600 ER cage rods (PN: ER6) to the top two mounting holes on the face of beam

splitter cube B, on the face closest to the laser diode module and front edge of the bread-

board as shown in Figure 11.
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Figure 11. Detail of the laser illumination arm with added alignment components

(A–C) ND filter with optical density of 1.0 (A), cage alignment plate (B), two 600 ER cage rods (C).
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b. Rotate the 1/200 post of the laser mount assembly to align the body of the laser module par-

allel to the 600 ER cage rods placed in step 17.a.

c. Place an absorptive ND filter with optical density of 1.0 (PN: NE10A-A) onto the ND filter holder

post positioned in front of the laser. This filter will reduce the laser optical power during align-

ment procedure. Remove this filter during experimentation and data collection. Ensure the filter

is perpendicular to the axis of laser illumination and there are no stray reflected beams.

d. Power on the laser diode module.

Note: Power the laser diode module using an associated regulated current controlled 5V po-

wer supply (e.g., PN: LDS5-EC). The electrical cable of the laser diode module may need to

be fit with the correct adapter.

e. Collimate the laser across the 600 ER cage rods in the near and far field using a cage alignment

plate (PN: CPA1). Adjust the focus ring on the laser diode module so that the laser spot size is

a consistent diameter whilst scanning the alignment plate towards and away from the laser

on the cage rods.

f. Position the cage alignment plate on the ER rods close to the laser diode module.

g. Adjust the laser illumination assembly left and right to align the laser beam in the center of

the vertical axis of the alignment plate.

h. Move the height of the 1/200 post up and down to align the laser beam in the center of the

horizontal axis of the alignment plate.

i. Position the cage alignment plate on the ER rods furthest away from the laser diode module.

j. Keeping the laser illumination assembly in its current position, rotate the 1/200 post to align

the laser beam in the center of the vertical axis of the alignment plate.

Note: During the alignment steps it may be necessary to tighten or loosen the thumbscrew

and mounting bolt of the laser mount assembly to arrest or permit movement as required.

k. Repeat steps 17.e–17.j until the laser beam is centered on the cage alignment plate and

collimated along the whole length of the ER cage rods.

l. Move the alignment plate position to the rear of the objective and confirm that the align-

ment of the laser beam is centered and collimated. If laser beam is not centered and colli-

mated, repeat the alignment procedure from steps 17.e–17.k. Once the alignment has

been completed, lock the position of the laser module by tightening the M6 bolt, post hold-

er thumb screw, and slip-on post collar thumbscrew.

Note: Due to the geometry of the beam splitter, you may need to align the laser beam off the

center horizontal axis along the ER cage alignment rods to ensure that the laser beam is
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collimated and incident center into the rear of the objective lens. Ensure it is still collimated and

parallel across the whole length of the rods and into the back of the center of the objective.

m. Adjust the position of the diffraction camera tube lens to one focal length (i.e., 100 mm) from the

focal plane of the condenser lens. Lock the position of the assemblyusing the cage plate set bolts.

n. Adjust the position of the diffraction camera so that its sensor is one focal length (i.e.,

100 mm) from the tube lens. Lock the position of the assembly using the cage plate set bolts

and base mounting bolt and thumbscrews.

o. While adjusting the focal ring of the laser, sequentially move the alignment plate between the

objective, condenser lens, tube lens, and diffraction imaging camera to optimize the laser

beam spot diameter to the smallest size possible whilst maintaining collimation throughout.

p. Connect the diffraction imaging camera to the computer and begin live video acquisition. In

the camera acquisition software, adjust the resolution, turn off auto exposure and auto white

balance, and manually adjust the exposure of the image such that it is not over exposed. If

the image of the laser is not centered on the camera sensor, repeat alignment steps 17.e–

17.k with minor adjustment to align it.

q. Power off the laser diode module.

r. Remove the alignment cage rods.

s. Remove the ND filter on the ND filter post holder.

Pause point: The system is now constructed and aligned. Further fine adjustments of the

alignment will require a prepared blood sample. It is advised to pause at this point and

only continue if there is sufficient time to complete the rest of the protocol.
18. Alignment optimization using a prepared blood sample.
a. Prepare a blood sample as outlined in the step-by-step method details: Blood collection and

preparation and prime the slit flow chamber.

b. Power on the laser diode module.

c. Set the syringe pump to the maximum shear condition desired during the experimental protocol.

d. While watching the image from the diffraction camera, adjust the position of the condenser

lens assembly forwards towards the slit flow chamber to a position where the elongated

diffraction pattern image fills �80–90% of the camera acquisition.

Note: The camera can be rotated within its housing to orientate alignment of the diffraction image

diagonally along the long axis of the camera sensor to maximize the captured region of interest.

e. While watching the brightfield imaging camera, focus the objective lens onto the optical sec-

tion of maximum shear just inside the wall of the slit flow chamber using the micrometer actu-

ator on the objective lens assembly. The optical plane can be identified when blood cells with

the largest elongation are in focus.

KEY RESOURCES TABLE
GENT or RESOURCE SOURCE IDENTIFIER

r

ination – Brightfield: 1 3 Quartz
sten-Halogen Lamp, M4 Tap

Thorlabs QTH10/M

ination – Brightfield: 1 3 Mounted Standard
36 mm Max Aperture, TR75/M Post

Thorlabs ID36/M

ination – Brightfield: 1 3
mm, Ø100 Achromatic Doublet,

-Threaded Mount, ARC: 400–700 nm

Thorlabs AC254-040-A-ML

(Continued on next page)
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Illumination – Brightfield: 1 3 SM1 (1.03500-40)
Coupler, External Threads, 0.500 Long

Thorlabs SM1T2

Illumination – Brightfield: 1 3 f=60 mm,
Ø100 Achromatic Doublet, SM1-Threaded
Mount, ARC: 400–700 nm

Thorlabs AC254-060-A-ML

Illumination – Brightfield: 1 3 Mounted N-BK7
Bi-Convex Lens, Ø100, f = 35.0 mm, ARC: 350–700 nm

Thorlabs LB1811-A-ML

Illumination – Brightfield: 2 3 SM1 Graduated
Ring-Actuated Iris Diaphragm (Ø1 - Ø12 mm)

Thorlabs SM1D12C

Illumination – Brightfield: 2 3 Coarse G1 mm XY Slip
Plate Positioner, 30 mm Cage Compatible, Metric

Thorlabs SPT1C/M

Illumination – Brightfield: 3 3
SM1-Threaded 30 mm Cage Plate with
Flexure Clamping, 1 Retaining Ring, M4 Tap

Thorlabs CP08/M

Illumination – Brightfield: 1 3 Cage
Assembly Rod, 1000 Long, Ø6 mm, 4 Pack

Thorlabs ER10-P4

Illumination – Brightfield: 3 3 Mounting
Base, 25 mm 3 58 mm 3 10 mm

Thorlabs BA1S/M

Illumination – Brightfield: 3 3 Ø12.7 mm
Optical Post, SS, M4 Setscrew, M6 Tap, L = 50 mm

Thorlabs TR50/M

Illumination – Brightfield: 1 3 Ø12.7 mm Post Holder,
Spring-Loaded Hex-Locking Thumbscrew, L=30 mm

Thorlabs PH30/M

Illumination – Brightfield: 2 3 Ø12.7 mm Post Holder,
Spring-Loaded Hex-Locking Thumbscrew, L=50 mm

Thorlabs PH50/M

Illumination – Brightfield: 3 3 Slip-On Post
Collar for Ø1/200 Posts, M6 Thumbscrew

Thorlabs R2/M

Illumination – Laser: 1 3 MR(14Ø) Circular
beam laser with integrated focus

Lanics LM-6305MR

Illumination – Laser: 1 3 Small Kinematic
V-Clamp Mount, Metric

Thorlabs KM100V_M

Illumination – Laser: 1 3 Ø100 Lens Mount with
SM1 Internal Threads and No Retaining Lip, M4 Tap

Thorlabs SMR1/M

Illumination – Laser: 1 3 Ø25 mm Absorptive
Neutral Density Filter, SM1-Threaded Mount,
ARC: 350–700 nm, OD: 1.0

Thorlabs NE10A-A

Illumination – Laser: 2 3 Mounting Base,
25 mm 3 58 mm 3 10 mm

Thorlabs BA1S/M

Illumination – Laser: 2 3 Ø12.7 mm Post Holder,
Spring-Loaded Hex-Locking Thumbscrew, L=50 mm

Thorlabs PH50/M

Illumination – Laser: 2 3 Ø12.7 mm Optical Post,
SS, M4 Setscrew, M6 Tap, L = 50 mm

Thorlabs TR50/M

Illumination – Laser: 1 3 Slip-On Post Collar
for Ø1/200 Posts, M6 Thumbscrew

Thorlabs R2/M

Central Arm and Sample Stage: 1 3 30
mm–60 mm Cage Plate Adapter, M4 Tap

Thorlabs LCP33/M

Central Arm and Sample Stage: 1 3 SM1
(1.03500-40) Coupler, External Threads, 0.500 Long

Thorlabs SM1T2

Central Arm and Sample Stage: 1 3
f=30 mm, Ø100 Achromatic Doublet,
SM1-Threaded Mount, ARC: 400–700 nm

Thorlabs AC254-030-A-ML

Central Arm and Sample Stage: 1 3 Z-Axis Translation
Mount, 30 mm Cage Compatible

Thorlabs SM1ZA

Central Arm and Sample Stage: 1 3 Adapter with
External SM1 Threads and Internal RMS Threads

Thorlabs SM1A3

Central Arm and Sample Stage: 1 3 Olympus
UPLAN FLN 103 Objective 0.30NA

Olympus 1-U2B524

Central Arm and Sample Stage: 1 3 Base Plate
for MS Series Translation Stages

Thorlabs MS101

Central Arm and Sample Stage: 1 3 6.5 mm
Travel Single-Axis Translation Stage with
Side-Mounted Micrometer, M4 Taps

Thorlabs MS1S/M

(Continued on next page)
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Central Arm and Sample Stage: 1 3 Ø12.7 mm
Post Holder, Spring-Loaded Hex-Locking
Thumbscrew, L=20 mm

Thorlabs PH20/M

Central Arm and Sample Stage: 1 3 Ø12.7 mm
Optical Post, SS, M4 Setscrew, M6 Tap, L = 20 mm

Thorlabs TR20/M

Central Arm and Sample Stage: 1 3 XY Mount
for 1/2" - 300 Rectangular Optics, M4 Taps

Thorlabs XYF1/M

Central Arm and Sample Stage: 3 3 Cage
Assembly Rod, 800 Long, Ø6 mm

Thorlabs ER8

Imaging – Diffraction: 1 3 S3CMOS Series
USB3.0 23.2 mm Eyepiece CMOS Camera

ToupTek S3CMOS05000KPA

Imaging – Diffraction: 1 3 C-Mount Aluminum
alloy Housing for S3CMOS

Thorlabs 108029(HS503)

Imaging – Diffraction: 1 3 Adapter with External
C-Mount Threads and Internal SM1 Threads

Thorlabs SM1A9

Imaging – Diffraction: 1 3 SM1 (1.03500-40)
Coupler, External Threads, 0.500 Long

Thorlabs SM1T2

Imaging – Diffraction: 2 3 SM1-Threaded 30 mm Cage
Plate with Flexure Clamping, 1 Retaining Ring, M4 Tap

Thorlabs CP08/M

Imaging – Diffraction: 1 3 Ø25 mm
Absorptive Neutral Density Filter, SM1-Threaded
Mount, ARC: 350–700 nm, OD: 1.0

Thorlabs NE10A-A

Imaging – Diffraction: 1 3 f=100 mm, Ø100 Achromatic
Doublet, SM1-Threaded Mount, ARC: 400–700 nm

Thorlabs AC254-100-A-ML

Imaging – Diffraction: 1 3 Cage Assembly
Rod, 600 Long, Ø6 mm, 4 Pack

Thorlabs ER6-P4

Imaging – Diffraction: 1 3 Mounting
Base, 25 mm 3 58 mm 3 10 mm

Thorlabs BA1S/M

Imaging – Diffraction: 1 3 Ø12.7 mm Post Holder,
Spring-Loaded Hex-Locking Thumbscrew, L=50 mm

Thorlabs PH50/M

Imaging – Diffraction: 1 3 Ø12.7 mm Optical Post,
SS, M4 Setscrew, M6 Tap, L = 50 mm

Thorlabs TR50/M

Imaging – Diffraction: 1 3 Slip-On Post Collar
for Ø1/200 Posts, M6 Thumbscrew

Thorlabs R2/M

Imaging – Optical: 1 3 S3CMOS Series
USB3.0 23.2 mm Eyepiece CMOS Camera

ToupTek S3CMOS05000KPA

Imaging – Optical: 1 3 C-Mount Aluminum
alloy Housing for S3CMOS

Thorlabs 108029(HS503)

Imaging – Optical: 1 3 Adapter with External
C-Mount Threads and Internal SM1 Threads

Thorlabs SM1A9

Imaging – Optical: 1 3 SM1 (1.03500-40) Coupler,
External Threads, 0.500 Long

Thorlabs SM1T2

Imaging – Optical: 1 3 SM1-Threaded 30 mm Cage
Plate with Flexure Clamping, 1 Retaining Ring, M4 Tap

Thorlabs CP08/M

Imaging – Optical: 1 3 SM1 Lens Tube, 0.3000

Thread Depth, One Retaining Ring Included
Thorlabs SM1L03

Imaging – Optical: 1 3 Ø25 mm Notch Filter,
CWL = 633 nm, FWHM = 25 nm

Thorlabs NF633-25

Imaging – Optical: 1 3 Cage Assembly
Rod, 300 Long, Ø6 mm, 4 Pack

Thorlabs ER3-P4

Imaging – Optical: 1 3 Mounting Base,
25 mm 3 58 mm 3 10 mm

Thorlabs BA1S/M

Imaging – Optical: 1 3 Ø12.7 mm Post Holder,
Spring-Loaded Hex-Locking Thumbscrew, L=50 mm

Thorlabs PH50/M

Imaging – Optical: 1 3 Ø12.7 mm Optical Post,
SS, M4 Setscrew, M6 Tap, L = 50 mm

Thorlabs TR50/M

Imaging – Optical: 1 3 Slip-On Post Collar
for Ø1/200 Posts, M6 Thumbscrew

Thorlabs R2/M

Cube Holders: 2 3 Kinematic 30 mm Cage
Cube Base, M6 Tapped Holes

Thorlabs DFM1BS/M

Cube Holders: 1 3 50:50 Non-Polarizing
Beamsplitter Cube, 400–700 nm, 100

Thorlabs BS013

(Continued on next page)
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Cube Holders: 1 3 30:70 (R:T) Non-Polarizing
Beamsplitter Cube, 400–700 nm, 100

Thorlabs BS019

Cube Holders: 1 3 Mounted N-BK7 Bi-Convex
Lens, Ø100, f = 50.0 mm, ARC: 350–700 nm

Thorlabs LB1471-A-ML

Cube Holders: 1 3 N-BK7 Bi-Convex
Lens, Ø100, f = 60.0 mm, ARC: 350–700nm

Thorlabs LB1596-A

Cube Holders: 1 3 SM1 Lens Tube, 0.3000

Thread Depth, One Retaining Ring Included
Thorlabs SM1L03

Cube Holders: 2 3 30 mm–60 mm Cage
Plate Adapter, 4 mm Thick

Thorlabs LCP4S

Cube Holders: 1 3 Cage Assembly
Rod, 200 Long, Ø6 mm, 4 Pack

Thorlabs ER2-P4

Cube Holders: 2 3 Mounting Base,
50 mm 3 75 mm 3 10 mm

Thorlabs BA2/M

Cube Holders: 2 3 Ø12.7 mm Post Holder,
Spring-Loaded Hex-Locking Thumbscrew, L=50 mm

Thorlabs PH50/M

Cube Holders: 2 3 Ø12.7 mm Optical
Post, SS, M4 Setscrew, M6 Tap, L = 50 mm

Thorlabs TR50/M

Cube Holders: 2 3 Slip-On Post Collar
for Ø1/200 Posts, M6 Thumbscrew

Thorlabs R2/M

Breadboard and Miscellaneous: 1 3 Aluminum
Breadboard, 450 mm 3 600 mm 3 12.7 mm, M6 Taps

Thorlabs MB4560/M

Breadboard and Miscellaneous: 1 3 Ø27.0 mm
Sorbothane Feet, Internal M6 Mounting Thread, 4 Pieces

Thorlabs AV4/M

Breadboard and Miscellaneous: 1 3
Spanner Wrench for SM1-Threaded Retaining
Rings, Graduated Scale with 0.02" (0.5 mm)
Increments, Length = 3.8800

Thorlabs SPW602

Breadboard and Miscellaneous: 1 3 Spanner
Wrench for SM1-Threaded Adapters, Length = 100

Thorlabs SPW909

Breadboard and Miscellaneous: 4 3 Snap-On
Plastic Dust Cap for SM1 Lens Tubes, 5 Pack

Thorlabs SM1EC2B

Breadboard and Miscellaneous: 1 3
6-Piece Balldriver Kit (1.5 mm, 2 mm,
2.5 mm, 3 mm, 4 mm, and 5 mm)

Thorlabs BD-KIT/M

Breadboard and Miscellaneous: 1 3 9-Piece
Balldriver Kit (0.05000, 1/1600, 5/6400, 3/3200,
7/6400, 1/800, 9/6400, 5/3200, and 3/1600)

Thorlabs BD-KIT

Breadboard and Miscellaneous: 1 3 M4 3
0.7 Stainless Steel Cap Screw, 10 mm Long, 50 Pack

Thorlabs SH4MS10

Breadboard and Miscellaneous: 1 3 M4 3
0.7 Stainless Steel Cap Screw, 12 mm Long, 50 Pack

Thorlabs SH4MS12

Breadboard and Miscellaneous: 1 3 M6 3
1.0 Stainless Steel Cap Screw, 10 mm Long, 25 Pack

Thorlabs SH6MS10

Breadboard and Miscellaneous: 1 3 M6 3
1.0 Stainless Steel Cap Screw, 12 mm Long, 25 Pack

Thorlabs SH6MS12

Breadboard and Miscellaneous: 1 3 M6 3
1.0 Stainless Steel Cap Screw, 20 mm Long, 25 Pack

Thorlabs SH6MS20

Breadboard and Miscellaneous: 1 3 #8
Washer, M4 Compatible, Stainless Steel, 100 Pack

Thorlabs W8S038

Breadboard and Miscellaneous: 1 3 1/400

Washer, M6 Compatible, Stainless Steel, 100 Pack
Thorlabs W25S050

Optional: 1 3 Charge-coupled device
(CCD) camera and frame grabber

Dantec Dynamics FlowSense EO 2M

Blood shearing equipment: Slit flow
shear chamber (m-slide)

ibidi GmbH Cat.No: 80161

Blood shearing equipment: Syringe pumps New Era
Pump Systems

NE-8000X

Software and algorithms

Image analysis (ImageJ) National Institutes
of Health

https://imagej.nih.gov/ij/

(Continued on next page)
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Statistical and graphical processing (e.g.,
open-source R or GraphPad Prism)

GraphPad Prism https://www.graphpad.com/
scientific-software/prism/

CAD file for guiding optical assembly. This paper;
Mendeley Data

https://doi.org/10.
17632/hhdrmftdg5.1

Chemicals, peptides, and recombinant proteins

Phosphate buffered saline
(PBS; 290 mOsmol$kg-1, pH 7.4)

Can be purchased
from Sigma-Aldrich

P3813

5% Polyvinylpyrrolidone in PBS (PVP; 290
mOsmol$kg-1, pH 7.4, 30 mPa$s)

Sigma-Aldrich PVP360

ll
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Note: Metric parts are listed; Thorlabs offers parts in both metric and imperial varieties.

Choose the variety which suits best for your laboratory environment.

Note: If you opt for metric components you will still require both metric and imperial hex

drivers and fixture hardware. Not all Thorlabs hardware are metric, even upon ordering metric

components.

Note: Ball head handled hex drivers allow for increased ease of access to fixture hardware.
STEP-BY-STEP METHOD DETAILS

Blood collection and preparation

Timing: 1 h

As the current protocol seeks to investigate blood cell dynamics, and blood cells are known to be

sensitive to ex vivo aging and shear history, blood quality and handling must be carefully considered

throughout the entirety of the protocol. After gaining informed consent from participants, the

following steps outline collection of blood as per international standards outlined in the new guide-

lines for hemorheological laboratory techniques (Baskurt et al., 2009a).

Note: hemorheological properties of blood cells begin to change at room temperature after

only 1 h. If experimentation cannot immediately be performed, kinetics of ex vivo aging can be

slowed by refrigerating blood samples at 4�C when not in use. Blood samples should be used

within 4–6 h of initial collection. Do not freeze blood samples, as this will lyse RBC. If storage

on ice is necessary, add an insulated boundary layer between the blood tubes and ice to elim-

inate direct contact.

CRITICAL: Given blood is potentially infectious, to avoid physical injuries to laboratory
members, only perform the following steps if appropriately trained in blood handling

and completely aware of the entire experimental procedure, local laboratory guidelines

and safety regulations, and use of requisite personal protective equipment (PPE).
1. Blood collection.
a. Identify a prominent vein in the antecubital fossa (other sites are also possible).

b. Sanitize the chosen site with alcohol or iodine.

c. Place tourniquet on proximal region of the upper arm (to facilitate vein distension).

d. Collect blood within 90 s of tourniquet application without removal.

i. To minimize shear exposure on blood throughout the collection process, for small volume

draws, a needle (with minimum a bore of 21 gauge) and syringe is recommended.

ii. Following collection, immediately transfer into anticoagulant coated blood tubes and

invert the tube gently 6–8 times to ensure adequate mixing.
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Note: Anticoagulants influence hemorheology. It is important to select the appropriate anticoag-

ulant for a specific use; for hemorheology and RBC biophysical investigations, EDTA (1.5–

1.8 mg$mL-1) and Heparin (14–15 U/mL) are widely used. Heparin has been reported to influence

hemorheology more than EDTA (Bartoli et al., 1986), thus EDTA is recommended where possible.

Greater detriment to microrheology is observed with increased concentrations of anticoagulants.

2. Blood preparation.

CRITICAL: RBC handling (centrifugation, transfer between containers, or wash steps)
should be kept to a minimum where possible. All solutions contacting blood must be isos-

motic (290 G 5 mOsmol$kg-1) and have a physiological pH (7.4 G 0.5). In the current pro-

tocol, phosphate buffered saline (PBS) was purchased from Sigma-Aldrich and consti-

tuted with buffering salts Na2HPO4$2H2O (0.01 M), KH2PO4 (0.0018 M), KCl (0.0027 M),

and NaCl (0.137 M). All final PBS solutions were confirmed to be 7.4 pH and 290 mOs-

mol$kg-1.
a. Following collection of whole blood into an anticoagulated tube, centrifuge at 1,500 3 g for

10 min to separate constituents of blood.

b. Carefully aspirate and remove the plasma and buffy coat, leaving isolated packed RBC.

c. Add phosphate buffered saline (PBS) to the approximate level of plasma and mix with gentle

inversion.

d. Centrifuge at 1,500 3 g for 5 min.

e. Carefully aspirate the PBS and discard.

f. Repeat steps 2.c–2.e to obtain a washed isolated pellet of packed RBC.

g. Mix packed RBC through gentle inversion and resuspend in a viscosity-controlled solution

(e.g., polyvinylpyrrolidone or dextran dissolved in PBS) at a low hematocrit (% �1 %).

Note: Knowing the viscosity of the solution is imperative for accurate shear quantification and

control. Measurement by viscometry is recommended (e.g., Brookfield viscometer). Resus-

pension at a low haematocrit facilitates optical clarity of the suspension, while overcoming

the non-Newtonian viscosity characteristics inherent to whole blood.

Microfluidic shear chamber assembly and control

Timing: 15 min

To ensure quantifiable and accurate shear control, two key experimental variables must be carefully

controlled: the viscosity of solution to be sheared (see blood collection and preparation), and the

dimensions of the shear chamber; controlling these parameters of the experimental design allows

flow rate to be independently manipulated to discretely control shear stress magnitude of exposure.

Note: The current experimental design utilized a commercially available slit flow shear cham-

ber (m-slide, ibidi GmbH; Cat.No: 80161) with a known working geometry of 0.2 3 5 3 50 mm

(H 3 W 3 L). Other commercially available or custom shear chambers may also be integrated

into the developed apparatus (e.g., Couette shear systems or microfluidic chambers); howev-

er, it is important to consider the optical characteristics of the shear device and the limited

working space between the microscope objective and condenser lens within the optical

setup. If using a slit flow chamber, to negate the effects of the shear stress induced by the

side wall on the channel’s width, imaging must be aligned at the center axis of the width

(W/2) position, and the width must be several times larger than the chamber height.

To control shear stress exposure within a slit flow shear system, a syringe pump (New Era NE-8000)

was used to progressively increase flow rate, and thus wall shear stress per the following formula:
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t =
6hQ

wh2

Where, t = wall shear stress (Pa)

h = viscosity of solution (Pa$s)

Q = volumetric flow rate (m3$s-1)

w = chamber width (m)

h = chamber height (m)

In the planar parabolic ‘slit flow’ shearing system, t represents the peak wall shear stress. Given the

shear profile across the axial region of the chamber is not constant, i.e., varies at different focal

depths of visualization, setting a consistent height of visualization and optical section will facilitate

comparative and precise data collection.

3. Shear chamber assembly.

See Figures 1 and 10 for reference of assembly.

a. Connect each of the shear chamber female luer lock ports to the male end of any two suitable

length intravenous extension tubes.

b. Connect the female end of one extension tube to a male luer lock syringe (this syringe will sub-

sequently be filled with the RBC-PVP suspension, inserted into the syringe pump and become

the shear chamber inlet).

c. The other extension tube connected to the shear chamber will become the outlet and will be

subsequently connected to a waste container.

d. Place the chamber in the sample stage holder and align it such that the luer ports are facing the

objective lens and beam splitter cube B.

e. Loosen the set screws of the sample stage holder and adjust where necessary the positions of

the clamping arms to place the shear chamber in between the two clamping arms horizontally.

f. Tighten the vertical set screws of the clamping arms to secure their position. Next tighten the

four horizontal set screws one after the other in a star pattern to affix the shear chamber.

Ensure it is positioned flush with the rear face of the clamping arm.

Note: Overtightening set screws may damage the shear chamber.

g. Position the shear chamber using the vertical and horizontal adjusters on the sample stage

holder to align the center of the shear chamber both vertically and horizontally with the optical

light path.

h. Place the outlet extension tubing into a suitable waste collection vessel or beaker.

Pause point: The shear chamber is now ready for filling and experimental deployment

4. Program syringe pump.

While the syringe pump can be manually controlled during experimental deployment, if using the

New Era NE-8000, a shear protocol can be designed and uploaded to the onboard controller

(e.g., McNamee et al. (2020) designed a shear protocol that increased flow rate every 15 s to allow

for 13 different shear stress stages (ranging 0.3–10 Pa) to be recorded).

Note: To allow for flow equilibrium and stabilization between each stage, only the last 10 s of

each stage is recommended to be recorded and subsequently analyzed.
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Pause point: The shear chamber and microfluidic control is now set up, programmed, and

ready for sample loading and experimental deployment.

5. Experimental deployment.

a. Place the syringe pump near the inlet of the shear chamber.

b. Load a syringe with the RBC-PVP sample prepared in ‘blood collection and preparation step

6e’ and secure it into the syringe pump mechanism with the associated set screws.

c. Connect the filled syringe to the female luer of the inlet shear chamber assembly.

d. Prime the system with the RBC solution and power on the light sources and acquisition cameras.

e. When RBC movement is confirmed to be stationary within the shear chamber, the syringe

pump shearing protocol can be initiated (synchronize this start time with the acquisition cam-

eras through dual control or triggered acquisition).

f. Acquire laser diffraction imaging and brightfield cell visualization for the period of the exper-

iment. These videos will be subsequently processed with image analysis routines.

g. Following conclusion of the test, the shear chamber can be cleaned and prepared for another

sample by cyclically washing and flushing the chamber with water and air.

Note: If using an acrylic chamber, for more thorough cleaning use an enzymatic cleaner. Do

not use ethanol-based products, as this can weaken the material causing hazing and cracking.

Pause point: The apparatus can now be reprimed for another test sample or covered and

packed away.

Image analysis and data processing

Timing: 1–3 h

Following experimental acquisition of a test sample, the laser diffraction and brightfield videos may

be imported into image analysis software for processing (the following steps describe processing

with ImageJ). The key variables of interest will be cell elongation index, cell orientation, and cell

counts (brightfield imaging only). The laser diffraction and brightfield images are analysed with

separate image analysis routines.

Note: Before performing the ‘‘Measure’’ function in each image analysis routine, ensure the

correct measurements are set; open the ‘‘Analyze’’ tab and select ‘‘Set Measurements’’ and

check ‘‘Fit ellipse’’ is selected.

Note: While the following protocol describes our analysis process, variations to the approach may

be required with different systems (especially with varied levels of light and contrast). Optimizing

pre-processing by enhancing contrast and removing unfocused cells can reduce image analysis

requirements. Validate each image analysis processing step at first initial setup/deployment. If

any noise created by internal reflection of the laser creating a bright spot is identified, given

the bright spot will not change location throughout the entirety of testing, the spot can be manu-

ally keyed out during initial processing if desired (see troubleshooting problem 2 for details).

6. Laser diffraction video analysis (Figure 12).
26
a. Import video or image stack into ImageJ. Depending on the saved filetype of the video this

process will vary slightly. If the stored filetype is not compatible for ImageJ, file conversion

using external software may be necessary (e.g., FFmpeg).

Note: The following steps describe the image analysis process for a single image at each

time point. The process can be applied to the entire stack by running the function as a

batched process macro. Details and macro script provided in step 1.j.
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Figure 12. Example image analysis processing of representative images collected from the laser diffraction

acquisition camera for a RBC-PVP suspension sheared at 0.3 and 10 Pa
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b. Once imported, ensure the stack dimensions are correct (i.e., synchronize timestamp/stack

interval with framerate and video sampling frequency). Image dimensions can be adjusted

in the ‘‘Image’’ tab, and ‘‘Properties.’’ subheading, or quick access with the ‘Ctrl+Shift+P’

shortcut.

c. Convert the image stack to 8-bit and grayscale.

Open the ‘‘Image’’ tab, open the ‘‘Type’’ subheading, and select the ‘‘8-bit’’ option.

d. Enhance contrast.

Open the ‘‘Process’’ tab and choose ‘‘Enhance Contrast’’ from the submenu. Run the function

with its default settings (i.e., 0.3% saturated pixels).

e. Apply a Gaussian Blur filter.

Under the ‘‘Process’’ tab, select ‘‘Filters’’, then ‘‘Gaussian Blur.’’. Input a sigma radius of 10 and

run the function.

f. Apply binary threshold.

Open the ‘‘Image’’ tab, select ‘‘Adjust’’, and select ‘‘Threshold.’’ (or access with the ‘Ctrl+-

Shift+T’ shortcut). In the submenu, change ‘‘Default’’ to ‘‘Otsu’’, and ensure laser diffraction

spot on the visible image slice is dark relative to the background before applying. If the diffrac-

tion pattern and laser spot is white, select the ‘‘Dark background’’ checkbox. Press ‘‘Apply’’ to

convert the image to a binary mask.

g. Remove outliers.

Open the ‘‘Process’’ tab, select the ‘‘Noise’’ submenu, and choose the ‘‘Remove Outliers.’’

function. Input a radius of 50, a threshold of 50, and select ‘‘Which outliers’’ as ‘‘Dark’’. Select

‘‘OK’’ to apply the function.

h. Fill holes.

Select the ‘‘Process’’ tab, ‘‘Binary’’ subheading, and choose the ‘‘Fill Holes’’ function.

i. Create automatic selection of shape.

Open the ‘‘Edit’’ tab, choose the ‘‘Selection’’ subheading, and select ‘‘Create Selection’’.

Optional: At this time point after a selection is created, the accuracy of the ellipse fit can

be visually evaluated by selecting ‘‘Fit Ellipse’’ under the ‘‘Edit’’ tab and ‘‘Selection’’

subheading.

j. Now that a selection has been created, measurements can be made (ensure ‘‘Set Measure-

ments’’ has already been performed for the ‘‘Fit ellipse’’ function). Open the ‘‘Analyze’’ tab

and select ‘‘Measure’’ (or access with ‘Ctrl+M’ shortcut). A results table will open with the vari-

ables of interest. Following batch processing of the entire image stack, the results table can

be saved as a CSV file to subsequently be processed in Excel.

Note: To perform steps 1b–1j as a macro, the following script can be used:
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run("8-bit");

run("Enhance Contrast...", "saturated=0.3");

run("Gaussian Blur...", "sigma=10");

setAutoThreshold("Otsu dark");

setOption("BlackBackground", false);

run("Convert to Mask");

run("Remove Outliers...", "radius=50 threshold=50 which=Dark");

run("Fill Holes");

run("Create Selection");

run("Measure");
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Macro scripts can be input, edited, and executed via:
Figu

acqu

28
i. The ‘‘Startup Macros.’’ function located under the ‘‘Plugins’’ tab and ‘‘Macros’’ subhead-

ing. In ‘‘Startup Macros.’’ ensure the ‘‘Language’’ selected is ‘‘IJ1 Macro’’ before input-

ting and executing the macro script.

ii. The ‘‘Batch Process’’ function, located in the ‘‘Process’’ tab, ‘‘Batch’’ submenu, and

‘‘Macro.’’ or ‘‘Virtual Stack.’’ option. In the ‘‘Batch Process’’ function, select the input

folder where images or image stack is located, then copy the macro script into the textbox

and select the ‘‘Process’’ button to execute.
7. Brightfield cell imaging video analysis (Figure 13):

a. Import video or image stack into ImageJ. Depending on the saved filetype of the video this

process will vary slightly. If the stored filetype is not compatible for ImageJ, file conversion

may be necessary using external software (e.g., FFmpeg).

b. Once imported, ensure stack dimensions are correct (i.e., synchronize timestamp/stack interval

with framerate/video sampling frequency). Image dimensions can be adjusted in the ‘‘Image’’

tab, and ‘‘Properties.’’ subheading, or quick access with the ‘Ctrl+Shift+P’ shortcut. The micro-

meter scale can be set in this menu by inputting the pixel/micron of system into the ‘‘Pixel width’’

and ‘‘Pixel height’’. Set these parameters to apply to all images by selecting ‘‘Global’’ checkbox.

c. Convert the image stack to 8-bit and grayscale.

Open the ‘‘Image’’ tab, open the ‘‘Type’’ subheading, and select the ‘‘8-bit’’ option.
re 13. Example image analysis processing of representative images collected from the brightfield illumination

isition camera for a RBC-PVP suspension sheared at 0.3 and 10 Pa
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d. Run Sobel edge detection.

Open the ‘‘Process’’ tab and select ‘‘Find edges’’.

e. Run the Ridge (Line) Detection plugin.

Under the ‘‘Plugins’’ tab, select ‘‘Ridge Detection’’. In the Ridge Detection function input:

Operational parameters: Line width = 1, High contrast = 400, Low contrast = 100

Mandatory parameters: Sigma = 0.73, Lower Threshold = 11.22, Upper Threshold = 45.22, Min-

imum Line Length = 35, Maximum Line Length = 100.

Select ‘Correct position’, and ‘Make Binary’. Uncheck all other options.

Select ‘‘OK’’ to execute.

Note: Given length and lines may depend on optical magnification and camera setup, prior

to executing, on initial image analysis testing use the preview function to optimize these vari-

ables for each different apparatus setup/camera.

f. Fill holes.

Select the ‘‘Process’’ tab, ‘‘Binary’’ subheading, and choose the ‘‘Fill Holes’’ function.

g. Remove outliers.

Open the ‘‘Process’’ tab, select the ‘‘Noise’’ submenu, and choose the ‘‘Remove Outliers.’’ func-

tion. Input a radius of 1, a threshold of 50, and select ‘‘Which outliers’’ as ‘‘Dark’’. Select ‘‘OK’’ to

apply the function.

h. Despeckle.

Open the ‘‘Process’’ tab, select the ‘‘Noise’’ submenu, and choose the ‘‘Despeckle’’ function.

i. Segment any grouped cells.

Open the ‘‘Process’’ tab, select the ‘‘Binary’’ submenu, and choose the ‘‘Watershed’’ function.

Now that the individual cells have been segmented, identification and measurement can be per-

formed (ensure ‘‘Set Measurements’’ has already been implemented for the ‘‘Fit ellipse’’ func-

tion). Open the ‘‘Analyze’’ tab and select ‘‘Analyze Particles.’’ (ensure ‘‘Display results’’ and

‘‘Exclude on edges’’ options are selected). A results table will open with the variables of interest.

Optional: For initial troubleshooting and optimization, in the ‘‘Analyze Particles’’ function,

prior to execution select ‘‘Show:’’ ‘‘Outlines’’ and ‘‘Add to Manager’’. Check the processed

image that is created and compare outlines on the ROI manager to original image by select-

ing the list of ROIs and pressing ‘‘Add’’ or ‘t’. If substantial errors exist, check initial process-

ing and thresholding boundaries.

Note: Rather than single frame analysis, batch processing can be performed using the macro

script provided below. This macro script can be altered for save preferences and filetype,

currently it will continually add analyzed frames to the ImageJ results output until directed

analysis is complete. The results output can then be saved as a CSV for each shear condition

and reset for subsequent analyses. Once each shear stage is processed and saved as a CSV

file, data analysis and processing can be performed in Excel.
ame = getTitle();

un("8-bit");

un("Find Edges");

un("Ridge Detection", "line_width=1 high_contrast=400 low_contrast=100

orrect_position make_binary method_for_overlap_resolution=NONE

igma=0.73 lower_threshold=11.22 upper_threshold=45.22

inimum_line_length=35 maximum=100");
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run("Fill Holes");

run("Remove Outliers...", "radius=1 threshold=50 which=Dark");

run("Despeckle");

run("Watershed");

run("Analyze Particles...", " show=Nothing display exclude");

close("*");
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8. Data analysis and processing.

Once successful ellipse fitting has been performed, the primary variables of interest can be deter-

mined; key variables include cell deformability (represented by an elongation index), cell orientation

relative to a C=0 orbit (i.e., cell long axis aligned with flow), and total cell counts. Once processed, all

data may be exported from excel into a open source or commercial software package for statistical

and graphical processing (e.g., R statistics or GraphPad Prism).

a. Using the excel data, an elongation index (EI) can be determined for each frame of the diffrac-

tion video, and each cell detected in the brightfield imaging video. To calculate EI, use the

columns labeled ‘‘Major’’ and ‘‘Minor’’ (referring to the long axis and short axis of the ellipse

respectively). Using these parameters, find the quotient of the difference and sum of the

long and short axes as follows:

Elongation index ðEIÞ =
long axis � short axis

long axis + short axis

EI can now be grouped for each shear stress condition and plotted, individually analyzed in histograms

for cell subpopulation deformability analysis, or plotted across time to assess shear stress stability.

b. Calculating orientation relative to C=0 orbit.

Using the excel data column labeled ‘‘Angle’’, cell orientation can be determined. Data provided

by ImageJ in this column references the angle of the long axis of the fit ellipse relative to 0/180� in

the horizontal plane and 90� in the vertical. Thus, to generate comparative data relative to an

aligned C=0 orbit, angles cannot be greater than 90�. Therefore, if an ellipse is reported to be

R90 degrees, 180� must first be subtracted, before the absolute value is found (i.e., if R 90�;
angle = jq � 180j). Data can now be processed through individual or group analysis.

Note: If all cells are included in the analysis, larger variance will be detected due to inconsis-

tent detection of long axis direction for cells with circular morphologies. To improve signal-to-

noise-ratio of cell orientation, angle data can be excluded for cells with a calculated EI below

0.2. The implemented filter will prefer angle analysis of cells with a rotated ‘side profile’ (with

long and short axes closer to 8 and 2 mm) rather than a ‘‘flat’’ circular morphology.

Cell orientation data can be processed and presented as shear-group averages or divided into

smaller data bins (10� groups) to assess population distributions of cell orientation in a given

shear flow.

c. Total cell counts analyzed.

The total number of cells analyzed can be determined simply by counting the number of lines ex-

ported to the CSV file. Perform the ‘Count’ function in excel of the leftmost column to achieve this.

EXPECTED OUTCOMES

Figure 14 displays typical examples of processed data obtained from the combined ektacytometer

rheometer optical system. Figures 14A and 14C exhibit typical EI-shear stress curves; EI (RBC de-

formability) is circular for cells in low-shear and becomes progressively more ellipsoidal in shape

as shear stress increases. Typical responses display a sigmoidal EI response to shear when plotted

on a semi-log axis.
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Figure 14. Example processed data acquired from the combined ektacytometer-rheometer optical system for a

healthy RBC-PVP sample sheared between 0.3 and 10 Pa

(A–D) RBC deformability (EI) curves are displayed for concurrently acquired laser diffraction data (A) and captured

brightfield visualization images (C). The stability of RBC in a constant 10 Pa shear flow and subsequent shape recovery

is presented (B). The orientation angle of RBC (relative to a C=0 orbit) is displayed for 10� groups for the entire RBC

population assessed within each shear condition (D).
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Note: To facilitate comparison between different experiment test groups (e.g., case-control

investigations), the EI-shear curve can be parameterized through curve-fitting the Linewea-

ver-Burk equation, where a theoretical maximal EI (EImax) and the shear stress required for

half maximal elongation (SS1/2) can be determined. The ratio of SS1/2:EImax can be subse-

quently calculated to generate a single parameter to reflect RBC deformability. This param-

eter has been reported to be robust for comparison of different RBC populations with varied

mechanical properties (for further information see Baskurt et al. (2009b)).

EI data can also be presented for all individual cells directly visualized in the brightfield analysis as

histograms to facilitate subpopulation inspection (for example see McNamee et al. (2020)). Using

the obtained laser diffractometry data, the stability of RBC in shear flow can also be analyzed across

time (e.g., Figure 14B). Using this technique, shape recovery responses can be assessed to infer

further physical properties of RBC. Figure 14D presents processed RBC orientation data obtained

from the directly visualized RBC in the brightfield analysis. Each shear condition is analyzed in 10�

data bins and presented as a relative count of total RBC analyzed within each shear condition.

Typical responses should exhibit large variance in cell orientation in very low shear flows (e.g., 0.3

Pa), with progressively more alignment as shear increases. In higher shear flows, most RBC should

be orientated and aligned with the flow vector.

The system described in the current manuscript provides the foundations of a custom apparatus that can

simultaneously inspect coaxial bright-field microscopy and laser diffractometry for flowing blood sam-

ples. While no commercially analogous devices currently exist on the market that can provide this

dual optical inspection, commercial ektacytometers (e.g., Laser-assisted Optical Rotational Cell

Analyzer, Mechatronics; and RheoSCAN-AnD300, RheoMeditech Inc.) provide an insight into how our

system could be developed further into a more user-friendly commercial system. Differences may exist

between diffractometry data obtained from our system and from other existing commercial
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ektacytometers, where part of the variance in the response may be due to methods of shear control (e.g.,

use of a syringe pump versus rotational bob-cup control or vacuum suction) or type of shear profile (e.g.,

planar parabolic ‘slit flow’ versus Couette-type shear; See limitations for further details). Nevertheless,

sacrificing the off-the-shelf commercial convenience in favor of in-house construction facilitates further

integration of more complex interrogation methods. We specifically developed our system with modular

sub-unit assemblies to enable future expansion of the optic apparatus to include i) epi-illumination for

biological fluorescent tagging and imaging, ii) optical tweezers for trapping flowing RBC for biophysical

inspection, and iii) integration of custom designed microfluidic devices and shear-rigs.
LIMITATIONS

Several major limitations exist with the design, development, and deployment of the current optical

rig, which can be improved as follows:

Using a planar parabolic ‘slit flow’ shearing system to induce controlled shear stimuli to RBC popu-

lations creates inconsistent RBC responses at varied depth throughout the chamber. This will create

inconsistencies between the laser diffractometry data (which includes all optical sections of cells in

the captured data) and the brightfield imaging data (which will be focused on a narrow optical sec-

tion nearest to the peak wall shear stress). Setting a consistent height of visualization and optical sec-

tion will facilitate comparative and repeatable data collection. The use of scanning multiple optical

depths with brightfield imaging or changing the shearing system to utilize Couette-type flow would

assist in negating this limitation.

The manual focusing process to obtain sharp RBC brightfield images in flow requires rapid, yet sen-

sitive adjustment while tracking RBC with fast velocities. This can result in suboptimal imaging qual-

ity or subsequent failure of image analysis and data production. This limitation can be mitigated with

careful adjustment and measurement of the objective lens using the translation stage micrometer

actuator. It is recommended that digital/automated Z-axis focusing be integrated into the optical

system to remove the time burden of this limitation.

Due to the mounting method of the shear chamber in the XY stage, keeping the chamber perpen-

dicular to the axis of illumination is difficult. This can be mitigated with careful alignment and with the

field of view of the objective lens, and firm fixation when in position.

If investigating kinetic deformability responses of RBC, variables of compliance/pressure, motor

backlash, and motor response times must be carefully considered.
TROUBLESHOOTING

Problem 1

No image incident on the cameras or illumination path issues during Optical system apparatus align-

ment or Experimental deployment.
Potential solution

� Ensure all the lens caps have been removed from the system before use.

� Check the orientation of the beam splitter cubes inside of the beam splitter cube holders are correct.

� Check the alignment and position of the optics sub-assemblies. Follow the alignment procedure

from the initial setup and readjust where necessary.
Problem 2

Noise created by internal reflection of the laser is creating a bright spot which is impacting identifi-

cation of clear diffraction images at Image analysis and data processing stages.
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Potential solution

Given the bright spot will not change location throughout the entirety of testing, the spot can be

manually keyed out during initial processing with the following method in ImageJ:

� Identify laser spot for removal and create a manual selection of the outline with an appropriate se-

lection tool.

� Add selection to ROI manager by pressing the ‘Ctrl+T’ shortcut. If the ROI manager is empty, the

new ROI should be in position 0 (i.e., the first position). This position will be referenced in the

macro script.

� Open the ‘‘Process’’ tab.

� Select the ‘‘Batch’’ submenu.

� Open the ‘‘Virtual Stack.’’ option.

� In the ‘‘Batch Process’’ function, select the input folder where images or image stack is located,

then copy the macro script into the textbox:
roiManager("Select", 0);
� Select the ‘‘Process’’ button to execute.

� The outlined ROI and laser spot should now be removed across all frames of video / image stack.

Problem 3

Large degree of light scatter with difficulty obtaining good focus in diffraction and brightfield im-

ages during Optical system apparatus alignment and experimental deployment.

Potential solution

The optical components may have been compromised and require cleaning. To isolate the problem

optic, follow the alignment procedure to narrow down afflicted subassembly. Once identified, clean

each optic with appropriate cleaning methods as outlined by Thorlabs (Thorlabs Inc., 2022) or

Edmund Optics (Edmund Optics Inc., 2022). Following cleaning, inspect each optic for physical

damage; if damaged, a replacement component may be required. To minimize cleaning require-

ments or risk of damage, it is advised that the assembly and use of the optical system be performed

in a dedicated clean area free from dust and other contaminants. Care should also be taken to keep

the optical components as clean as possible by wearing surgical gloves when assembling, handling,

or using any part of the system. Users should never directly handle or touch optical surfaces.

Problem 4

Non-uniform focus across field of view in the brightfield imaging camera in Optical system apparatus

alignment or Experimental deployment.

Potential solution

Check the alignment of all optical components as per system assembly and alignment instructions.

Importantly, check that the slit flow shear chamber is fixed firmly in the sample stage holder and

perpendicular to the optical axis. If the set screws are not holding the chamber in place, extra

methods of fixation (e.g., tape) may be applied. Alternatively, new/custom sample stage holders

can be designed to fit each specific type of shear chamber and manufactured/3D printed to

specification.

Problem 5

Laser diffraction and brightfield imaging generates inconsistent data between repeated experi-

mental tests in Data analysis and processing.

run("Clear", "slice");
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Potential solution

The use of a slit flow shearing system to induce controlled shear stimuli to RBC populations creates

inconsistent RBC responses at varied depths throughout the shear chamber. To facilitate compara-

tive and repeatable data collection, a consistent height of visualization and optical section must be

set and fixed by using (and marking) the micromanipulator on the stage assembly. The use of scan-

ning multiple optical depths with brightfield imaging or changing the shearing system to utilize Cou-

ette-type flow can assist in negating this problem entirely.
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